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AKVIS COLORIAGE AI 15.5 | ADD COLOR TO BLACK AND WHITE PHOTOS

AKVIS Coloriage AI allows you to colorize black and white photos and replace colors in color images. The cutting-edge
technology will change your ideas about image colorization forever!

The program includes an AI-powered image colorization mode based on machine learning, as well as the classic method of
manual coloring using zone selection.

Breathe life into your black and white photos!

AKVIS Coloriage AI manipulates the colors in your images: from colorizing old black-and-white scans to replacing colors in
color pictures.

The software creates natural-looking colorization in a quick and entertaining manner. It works equally well for coloring of
portraits, landscapes, fashion, and still life.

Make a present for your grandmother by adding color to her school photo, restore and colorize old pictures. See your family
archive in color! The program helps you to preserve cultural heritage for future generations.
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The program is the most comprehensive way to colorize images. It uses not only the groundbreaking technology of machine
learning and neural networks, but also includes the old good method of manually identifying zones in an image and assigning
colors to these areas.

AI-Based Image Colorization Algorithm

The neural network colorizes black and white photos, recognizing edges without going beyond the contours and applying
colors as close as possible to reality.
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Unlike many other AI colorization tools and services based on machine learning, the program does not require an Internet
connection; it works in the full-featured mode both in the trial period and under the lifetime license.

Using Coloriage AI, you will get bright and vivid colorization with a single mouse click! Just press the Run button. It's possible
to edit the result adjusting the Sensitivity and Saturation parameters and using the post-processing tools.

Colorize your photos effortlessly with Coloriage AI!
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Classic Color Zoning Method

This is a combination of manual (marking areas) and automatic (coloring) modes. It's as easy to use as a coloring book.
Indicate the desired colors by the pencil strokes; the program does the rest of the work: recognizes the object's borders and
tailors the new color to the grayscale tones of the initial picture. The skin, sky, verdure, and tree color patterns help users to
select realistic colors for their picture. You can also upload any photo as a reference and copy colors directly from it.
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The software also includes a set of post-processing brushes that help to edit colorization results. These useful tools are
available in both AI and Classic modes.

Use the Recolor Brush, Tuning Brush, Darken, Lighten, and Saturation tools at the final stage of the workflow. The
History Brush allows you to return the image to the original state and fade the effect.

Apply your creativity and find a wide variety of other usages for the software! You can create colorful backgrounds out of
ordinary dull pictures, use Coloriage AI to get rid of the red eye effect, to make selective desaturation and colorizing, etc.

Colorful examples of application of the program best illustrate the capabilities of Coloriage AI.
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In the AI mode, the software provides the Batch Processing feature that allows you to automatically colorize multiple
images at once. Just choose a folder with black and white photos or with frames of a black and white movie. All images will
be colorized automatically!

AKVIS Coloriage AI is available in two versions – as a standalone program and as a plugin to a photo editor.

The plugin version integrates smoothly with image editing software like AliveColors, Adobe Photoshop, Photoshop Elements,
Corel PaintShop Pro, etc. Check the compatibility with your graphic editor.
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INSTALLATION ON WINDOWS

Please find instructions below on how to install the AKVIS programs on Windows.

You must have administrator rights to install the program on your computer.

Before installing the AKVIS plugins, please make sure that the image editor where you want to install the plugins, is closed. Or
re-run the image editor after the installation of the plugin.

 

1. Run the setup exe file.
2. Select your language and press the Install button.
3. To continue the installation process you have to read and accept the End User License Agreement.

Activate the check box "I accept the terms in the License Agreement", and press Next.

4. To install the Plugin, select your photo editor(s) from the list.

To install the Standalone version, make sure that the corresponding option is activated. 
To create a shortcut for the program on desktop, activate Desktop Shortcut.

Press Next.

5. Press the Install button.
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6. The installation is in progress.

7. The installation is completed.

You can subscribe to the AKVIS Newsletter to be informed about updates, events, and special offers. Enter your e-
mail address and confirm that you accept the Privacy Policy.
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8. Press Finish.

After installation of the standalone version, you will see the program name in the Start menu and a shortcut on the
desktop, if during installation the corresponding option was enabled.

After installation of the plugin, you will see a new item in the Filter/Effects menu of your photo editor. For example in
Photoshop: Filter -> AKVIS –> Coloriage AI, in AliveColors: Effects -> AKVIS –> Coloriage AI.
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INSTALLATION ON MAC

Follow the instructions to install the AKVIS software on a Mac computer.

You must have administrator rights to install the program on your computer.

 

1. Open the dmg file:

- akvis-coloriage-app.dmg to install the Standalone version

- akvis-coloriage-plugin.dmg to install the Plugin into your image editor.

2. Read the License Agreement and press Agree, if you agree with the conditions.

3. Finder will open with AKVIS Coloriage AI application or AKVIS Coloriage AI PlugIn inside.

 

4. To install the Standalone version, drag the AKVIS Coloriage AI app into the folder Applications (or any other place
you like).

To install the Plugin, drag the entire AKVIS Coloriage AI PlugIn folder into the Plug-Ins folder of your graphic editor:

AliveColors: You can choose in the Preferences the folder of the plugins.

Photoshop CC 2023, CC 2022, CC 2021, CC 2020, CC 2019, CC 2018, CC 2017, CC 2015.5:
Library/Application Support/Adobe/Plug-Ins/CC;

Photoshop CC 2015: Applications/Adobe Photoshop CC 2015/Plug-ins;

Photoshop CS6: Applications/Adobe Photoshop CS6/Plug-ins.
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AKVIS Plugins on Mac
(click to enlarge)

After installation of the plugin, you will see a new item in the filters/effects menu of your photo editor. Select in Photoshop:
Filter -> AKVIS -> Coloriage AI, in AliveColors: Effects -> AKVIS -> Coloriage AI.

Run the standalone application by double-clicking on its icon in Finder.

You can also run the AKVIS programs from the Photos app by choosing the Image -> Edit With command (in High Sierra and
later versions of macOS).

 

AKVIS Coloriage AI
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INSTALLATION ON LINUX

Note: The AKVIS programs are compatible with Linux kernel 5.0+ 64-bit. You can find out the kernel version using
the uname -srm command.

 

Follow the instructions to install the AKVIS software on a Linux computer.

 

Installation on Debian-based systems:

Note: You need apt-install or apt-get permissions required to install software.

1. Run the terminal.
2. Create a directory to store keys:

sudo mkdir -p /usr/share/keyrings 

3. Download the key that signed the repository:

curl -fsSL https://akvis.com/akvis.gpg | sudo tee /usr/share/keyrings/akvis.gpg >/dev/null 

or

wget -O - https://akvis.com/akvis.gpg | sudo tee /usr/share/keyrings/akvis.gpg >/dev/null 

4. Add the repository to the list where the system looks for packages to install:

echo 'deb [arch-=i386 signed-by=/usr/share/keyrings/akvis.gpg] https://akvis-deb.sfo2.cdn.digitaloceanspaces.com
akvis non-free' | sudo tee /etc/apt/sources.list.d/akvis.list 

5. Update the list of known packages:

sudo apt-get update 

6. Install AKVIS Coloriage AI

sudo apt-get install akvis-coloriage 

7. The installation is completed.

Launch the program via the terminal or using the program shortcut.

8. For automatic updates, use the command:

sudo apt-get upgrade 

To remove the program:

sudo apt-get remove akvis-coloriage --autoremove 

 

Installation on RPM-based systems (CentOS, RHEL, Fedora):

1. Run the terminal.
2. Register the key that signed the repository:

sudo rpm --import https://akvis.com/akvis.asc 

3. Add the repository to the system:

sudo wget -O /etc/yum.repos.d/akvis.repo https://akvis.com/akvis.repo 

4. Update the package list:

when using the dnf package manager:

sudo dnf update 

when using the yum package manager:

sudo yum update 

5. Install AKVIS Coloriage AI:

AKVIS Coloriage AI
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when using the dnf package manager:

sudo dnf install akvis-coloriage 

when using the yum package manager:

sudo yum install akvis-coloriage 

6. The installation is completed.

Launch the program via the terminal or using the program shortcut.

7. For automatic updates:

when using the dnf package manager:

sudo dnf upgrade 

when using the yum package manager:

sudo yum upgrade 

8. To remove the program:

when using the dnf package manager:

sudo dnf remove akvis-coloriage 

when using the yum package manager:

sudo yum remove akvis-coloriage 

 

Installation on openSUSE.

1. Run the terminal.
2. Login as a root user.
3. Add the key that signed the repository:

rpm --import http://akvis.com/akvis.asc 

4. Add the repository to the system:

zypper ar -r https://akvis.com/akvis.repo akvis 

5. Update the package list:

zypper ref 

6. Install AKVIS Coloriage AI:

zypper install akvis-coloriage 

7. The installation is completed.

Launch the program via the terminal or using the program shortcut.

8. For automatic updates:

zypper update 

To remove the program:

zypper remove akvis-coloriage 

 

Installation using Flatpak:

1. Run the terminal.
2. Add the Flathub repository

sudo flatpak remote-add --if-not-exists flathub https://flathub.org/repo/flathub.flatpakrepo 
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3. Add the AKVIS repository

sudo flatpak remote-add --if-not-exists akvis --from https://akvis-
flatpak.sfo3.cdn.digitaloceanspaces.com/com.akvis.flatpakrepo 

4. Install AKVIS Coloriage AI:

sudo flatpak install -y akvis com.akvis.akvis-coloriage 

5. The installation is completed.

Launch the program using the program shortcut or the terminal:

flatpak run com.akvis.akvis-coloriage 

6. To update all installed flatpaks, use the command:

sudo flatpak update -y 

to remove the program:

sudo flatpak remove -y com.akvis.akvis-coloriage 

 

In order to display the program interface correctly, it is recommended to install the Compton or Picom composite manager.
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AKVIS SOFTWARE ACTIVATION

Attention! During the activation process your computer must be connected to Internet.

If it is not possible, we offer you an alternative way (see below for Offline Activation).

 

Download AKVIS Coloriage AI and install the program. Read the Installation Instruction here.

When you run the unregistered version, a splash window will appear displaying general information about the version and the
number of days left in your trial period.

You can also open the About the Program window by pressing the button  in the program's Control Panel.

 

Click on TRY IT to evaluate the software. A new window will appear with variants of licenses to test.

You do not need to register the trial version to try all features of the software. Just use the program during the evaluation
time (10 days after the 1st start).

During the test period you can try all options and choose the license you like. Select one of the offered functionality types:
Home (Plugin or Standalone), Home Deluxe, or Business. Your choice of license will affect which features will be available
in the program. Consult the comparison table for more details about license types and versions of the software.

If the trial period has expired, the TRY IT button is disabled.

 

Click on BUY NOW to choose a license to order.

When the payment is effected, your serial number for the program will be sent to you within minutes.

 

Click on ACTIVATE to start the activation process.

AKVIS Coloriage AI
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Enter your name (the program will be registered to this name).

Enter your serial number (your license key).

Choose the method of activation — either direct connection to the activation server or by e-mail.

Direct connection:

We recommend activating the program using direct connection, as it is the easiest way.

At this step your computer must be connected to Internet.

Press ACTIVATE.

Your registration is completed!

Request by e-mail:

In case you have chosen activation by e-mail, a message with all necessary information will be created by the program.

NOTE: You can also use this method for Offline Activation:

If your computer is not connected to Internet, transfer the activation message to a computer connected to Internet,
for example, with a USB stick. Send us this information to: activate@akvis.com.

Please do not send the screenshot! Just copy the text and save it.

We need your serial number for the software, your name, and HardwareID (HWID) of your computer.

We will generate your license file (Coloriage.lic) using this information and will send it to your e-mail address.

Save the .lic file (do not open it!) to your computer where you want to register the software, in the AKVIS folder in
Users’ Shared (Public) Documents:

Windows:

C:\Users\Public\Documents\AKVIS

(This PC > Local Disk (C:) > Users > Public > Documents > AKVIS)

Mac:

/Users/Shared/AKVIS

Open the Finder,  se l ec t  the  Go menu,  then se lec t  Go to Folder... (⌘ +Shift+G ) ,  t ype

"/Users/Shared/AKVIS", and click Go.

Linux:

/var/lib/AKVIS

Your registration is completed!
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When the program is registered, BUY NOW turns to UPGRADE that lets you improve your license (for example, change
Home to Home Deluxe or Business).
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WORKSPACE

AKVIS Coloriage AI can work independently as a standalone program and as a plug-in to a photo editor.

Standalone is an independent program. You can run it in the usual way.
Plugin is an add-on for image editors. To call the plugin, select it from filters of your image editor.

The AKVIS Coloriage AI workspace is arranged according to the image colorization mode chosen in the Control Panel: AI or
Classic.

Click AI to switch to the switch to automatic colorization mode that uses neural networks and machine learning algorithms.

Workspace of AKVIS Coloriage AI (AI Mode)

The Classic mode is intended for colorization using with colored strokes and zone selection.

Workspace of AKVIS Coloriage AI (Classic Mode)

Most of the AKVIS Coloriage AI window is taken by the Image Window with two tabs: Before and After. In the Before
tab you can see the original photo; the After tab shows the resulting image.
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In the upper part of the program's window you can see the Control Panel with the following buttons:

The button  opens the home page of AKVIS Coloriage AI.

The button  (only in the standalone version) opens an image for processing. The hotkeys for the command are

Ctrl+O  on Windows, ⌘ +O  on Mac.

The button  (only in the standalone version) saves an image to the disk. The hotkeys are Ctrl+S  on Windows,

⌘ +S  on Mac.

The button  (only in the standalone version) prints the image. The hotkeys are Ctrl+P  on Windows, ⌘ +P  on

Mac.
The button  (only in the AI mode) opens the Batch Processing dialog to automatically colorize a series of images.

These buttons are designed for working with colored strokes and available in the Classic mode:

The button  opens files with the .strokes extention. These are the files where you save strokes drawn on an

image.
The button  saves color strokes drawn on an image into a file with the .strokes extension. It is helpful when you

want to edit the photo later, for example, if you have to interrupt your work before you have drawn the strokes for all
objects.
The button  cancels the last operation. It is possible to cancel several operations in a row. The hotkey for the

command is Ctrl+Z  on Windows, ⌘ +Z  on Mac.

The button  returns the last cancelled operation. It is possible to return several operations in a row. The hotkey for

the command is Ctrl+Y  on Windows, ⌘ +Y  on Mac.

The button  /  /  helps to switch between view modes of the strokes.

 - this state indicates that normal mode is active. All strokes are displayed in the chosen color, i.e. various tones of

the same color will look the same.
 - this state indicates that Brightness Preview mode is active. In this mode the strokes are displayed taking into

account the brightness of pixels of the original image and the selected brightness range.
 - this state indicates that the strokes are hidden.

These buttons are available in both modes:

The button  allows you to start the colorization process. The shortcut to start the image colorization from the

keyboard is Ctrl+R  on Windows, ⌘ +R  on Mac. The resulting image is shown in the After tab.

The button  (only in the plugin version) applies the result of the colorization. When you press the button, the

changes are applied to the image and the AKVIS Coloriage AI window closes.
The button  shows information about the program.

The button  opens the help files of the program.

The button  calls the Preferences dialog box for changing the program's options.

The button  opens a window showing the latest news about Coloriage AI.

 

To the left of the main window there is a Toolbar which contains tools for adding and editing colored strokes (in the Classic
mode), as well as tools for fine-tuning the colorized image (in both AI and Classic modes). Different tools appear depending
on the active tab, Before or After.

The options of the active tool are shown in the floating window that appears when you right-click any part of the Image
Window. If you click outside of the floating window, it disappears.

Navigate and scale the image using the Navigator. In the Navigator you can see the reduced copy of the image. The frame
shows the part of the image that is now visible in the Image Window; the areas outside the frame will be shaded. Drag the
frame to make other parts of the image visible. To move the frame, bring the cursor inside the frame, press the left mouse
button and, keeping it pressed, move the frame in the Navigator.
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Navigator

Use the slider to scale the image in the Image Window. When you move the slider to the right, the image scale increases.
When you move the slider to the left, the image scale decreases.

To scroll the image in the Image Window, you can press the spacebar on the keyboard and drag the image with the left
mouse button. Use the scroll wheel of the mouse to move the image up/down, by keeping the Ctrl  key pressed (Mac: ⌘ ) –
to the left/to the right, by keeping the Alt  key pressed (Mac: Option ) − scale the image. Right-click the scroll bar to
activate the quick navigation menu.

You can also change the image scale by entering a new coefficient into the scale field and pressing the button Enter

(Return  in Mac). The drop-down menu shows some frequently used coefficients.

You can use hotkeys to change the image scale +  and Ctrl++  (⌘ ++  in Mac) to increase the image scale and -  and

Ctrl+-  (⌘ +-  in Mac) to reduce the scale.

 

Under the Navigator, there is a Settings Panel configured depending on the selected mode.
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USING THE PROGRAM

AKVIS Coloriage AI creates natural-looking colorization in a quick and entertaining manner. Coloriage AI manipulates colors
of an image: from colorizing old black and white photos from your family archive to replacing colors in your color photos.
Coloriage AI can work independently as a standalone program and as a plug-in to a photo editor.

Follow the instructions to colorize a photo with the AKVIS Coloriage AI:

Step 1. Open an image.

- If you work with the standalone version:

To load an image, you can double-click within the empty window, drag the image into the program workspace, or use 
. The software supports RAW, JPEG, PNG, BMP, TIFF, and WEBP file formats.

- If you work with the plugin:

Open an image in your graphics editor.

If the image in Grayscale mode, switch it to RGB. For example, in AliveColors use command: Image -> Mode -
> RGB.

Call the AKVIS Coloriage AI plug-in from the Filter/Effects menu:

in AliveColors: Effects -> AKVIS -> Coloriage AI; 
in Adobe Photoshop: Filter -> AKVIS -> Coloriage AI; 
in Corel PaintShop Pro: Effects –> Plugins -> AKVIS –> Coloriage AI; 
in Corel Photo-Paint: Effects -> AKVIS -> Coloriage AI.

Step 2 (optionally). You can adjust the brightness and contrast of the original image in the Preprocessing tab.
Step 3. Select the colorization mode: AI or Classic.

In AI mode, the program uses trained neural networks that select the most suitable colors and apply them to your
photo.

In Classic mode, it's possible to colorize the image using colored strokes. Indicate areas with strokes of the desired
color. The program will recognize the object's borders and colorize the image with the selected colors.

Step 4. Press the button  to start the process. The colorized image will be shown in the After tab.

If you want to edit the colorization result (remove some strokes, add new strokes, change the color of the objects),
activate the Before tab again and make the necessary corrections. Click the button  again to re-start processing.

Step 5. It is possible to add the result into the Variations section by clicking  in the Toolbar. You can switch

between the results to compare different versions of colorization. To remove a picture from the list, click .

Note: This feature is only available for the Home Deluxe and Business licenses.
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Variations of Colorization

Hints: Loading a new image into the program removes all images in the Variations. Save your favorite results
under new names.

You can hide Variations in the program Preferences .

Step 6. In the last stage of work you can manually edit the colorized image using the post-processing tools (in the
After tab): Recolor Brush , Tuning Brush , History Brush , Darken , Lighten , Saturation .

Attention! Use these brushes at the final step! If you re-run processing  or switch between the images in

Variations, the changes made with the tools will be lost.

Step 7. In the standalone version, you can also print your result using .

Step 8. Save the processed image.

- If you work with the standalone edition:

Click  to open the Save As dialog box. Enter a name for the file, choose the format (TIFF, BMP, JPEG, PNG,

or WEBP) and indicate the target folder.

- If you work with the plugin:

Press the button  to apply the colorization result to your picture and close the plugin window. The plugin will

close and the colored image will appear in the workspace of the photo editor.

Call the Save As dialog box using the command File -> Save As, enter a name for the file, choose the format
and indicate the target folder.

Colorized Image
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AI MODE

In AI mode, the program colorizes an image using neural networks. In this mode, you can't choose colors, the program uses
artificial intelligence to select the most suitable colors and carefully apply them to a photo.

For example, here is an original black and white photo:

Click the Run button  to start the colorization process. The result will be shown in the After tab.

You can edit the result by adjusting the Sensitivity and Saturation parameters.

Use the Sensitivity parameter to change tones when the colors seem monotonous and dull. It's also helpful if the image is
old, noisy, compressed, or damaged.

Change the brightness of colors using the Saturation parameter.

Colorization Result
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In the After tab, you can edit the colorized image using the post-processing tools: , , , , , .
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CLASSIC MODE

In Classic mode, you can colorize the image using colored strokes. Schematically mark areas with strokes of the desired
color. The program will recognize the object's borders and apply the selected colors to the original picture.

In the Coloring tab, select colors for the object you want to colorize. There are several ways to select colors: in the Color
Library, in the Color, Swatches, and Multicolor palettes, in the Select Color standard dialog, or from the Sample Image.

In the Before tab, mark areas in the original image using the Pencil  and other tools that help you to indicate colors for

objects. If you do not specify a color for an object, then it will be colorized in the color of the object(s) nearest to it.

You can use the protecting Keep Color Pencil  to mark objects and areas to remain unchanged. These protecting stokes

are shown as lines with checkerboard fill.

A selection made in the graphics editor will be transferred to the plug-in and displayed as the outline made with .

The Eraser tool  helps to remove or edit the drawn strokes.

Use the Tube  and Magic Tube  to quickly change colors of the drawn strokes.

It is recommended to save the color strokes into a file (*.strokes) by clicking . Later, you can load the saved stroke map

using . In case of some unexpected event (such as a power loss, etc.) the program automatically saves the strokes into

the coloriage-autosave.strokes file each time when you run processing .

Press the Run button  to start the coloring process. The colorized image will be shown in the After tab.

If you want to edit the colorization result (remove some strokes, add new strokes, change the color of the objects), switch
to the Before tab and make the necessary corrections. Click  again to re-start image processing.
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Colorization Result

In the After tab, you can edit the colorized image using the post-processing tools: , , , , , .
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COLOR SELECTION FOR IMAGE COLORIZATION

AKVIS Coloriage AI offers several ways to select colors in the Classic mode. In the AI mode, the neural network chooses
colors. Also, color selection options are useful for some post-processing tools that can be applied in both AI and Classic
modes in the After tab.

In the AI mode, you can use the Color and Swatches palettes as well as the Color History to select color for the brushes.

In the Classic mode, the Coloring tab contains the Color Library, the Sample Image section, the Color History, as well
as the Color, Swatches and Multicolor palettes.

When selecting colors, please take into account that the colorized photo will look more natural if you apply less saturated
colors.

 

The Color History keeps the last used colors. Once you draw with a color, it appears in the History, so you can quickly back
to one of the recently applied tints.

 

Color Palette

When working with this palette, you select a color from the spectrum displayed on the color scale. The cursor here takes the
shape of an eyedropper. To set a new color, just click the eyedropper inside the scale. The current color is displayed in a
color box. Double-clicking on it brings up the standard Select Color dialog.

You can change the tone of a color or get a new color altogether by adjusting the sliders or entering new values for color
components in the input fields.

Right-clicking on the same box opens a menu of available color modes: gray tones (Grayscale), RGB, Lab, and CMYK.

The gradient line above the Color palette will show the selected color and its shades according to their brightness.

Below the gradient line you can set the brightness of the current color. By default the brightness range is complete, i.e. the
black pixels on the image correspond to the darkest shades of the selected color, while the white pixels correspond to the
lightest shades of the selected color.

To change the brightness range, move the markers of the black and/or white points on the gradient line. Thus you set the
darkest or/and the lightest possible color shade for the object. If you set a darker shade for the white marker, you will be
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able to color a light object a darker color; if you set a lighter point for the black marker, you will be able to color a dark area a
lighter color. You can not reduce the range more than twice.

You can store your favorite or frequently used colors in a special mini-palette.

To add a color to the mini-palette, click the selected color and drag it a box. To change the main color to that in a box, left-
click the box. To remove the color from the box, right-click the box.

 

Swatches Palette

The Swatches palette contains a collection of frequently used colors. To select a color from the set, just click it with the
left mouse button. As in the Color palette, the selected color will be shown in the color box.

The buttons at the bottom of the palette have the following uses:

The Add Swatch button  adds the current color to the collection of swatches.

To delete a color drag it to the basket  or choose Delete Swatch from the menu.

The Save Into File button  opens a dialog where swatches can be saved (files ending in .swatches).

The Load From File button  loads a saved collection of swatches so that they can be used again.

The Reset Defaults button  resets the collection of swatches to their original settings.

 

Color Library

The Color Library contains colors that are difficult to pick out: the color of skin, hair, lips, grass, trees, stones, etc. All
colors in the Color Library are divided into groups in accordance with their function. To select a color from the Color
Library:

Select a color group from the tree by left-clicking it. The colors within the group represent a gradient.
Select a gradient by left-clicking it. As a result the chosen color appears in the upper gradient line under the Color
Library. The marker shows the color you clicked on.
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Select a color on the upper gradient line by left-clicking it. The marker will fix this color and the lower gradient line will
show the shades of the selected color according to their brightness.

To save a gradient in a separate group, select it and click the Add to Favorites button. To delete a gradient from the
Favorites group, select it and click the Remove from Favorites button.

 

Sample Image

In this tab, you can pick colors from any other image with the eyedropper . The active tool (for example, Pencil ) will

automatically start drawing with the selected color.

Load an image using  or double-clicking within the empty space in this tab or dragging the image into this tab. Right-click

the button  to display a list of recently used files.

To zoom in or out on the sample image, use the drop-down list.
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Eyedropper Tool

You can also select a color directly from the image. To do this, enable the Eyedropper tool  and left-click any point of

the image, including drawn strokes.

When you click in the image with the eyedropper, it displays a Color Ring with 5 sectors that shows the information about
the colors in this area:

1. Gradient line with the current color in the center, on the left side is +30% black, and on the right side +30% white.

2. The previously selected color.

3. The current color of the pixel where the cursor is.

4. Colors of surrounding pixels.

5. Average colors from areas of 3x3, 5x5, 11x11, 31x31, 51x51, 101x101 px (around the eyedropper's tip).

Hint: The Color Ring helps to select colors more precisely. If it's hard to catch a certain color, select the desired tint on
the ring while holding the Ctrl -key.

 

And let's repeat: The colors on the photo will look more natural if you select less saturated colors.
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PRE- AND POST-PROCESSING TOOLS

In AKVIS Coloriage AI, the Toolbar changes when switching between the Before and After tabs, depending on the selected
mode AI/Classic, and looks like this:

Toolbar 
Before Tab
AI Mode

Toolbar 
Before Tab

Classic Mode

Toolbar 
After Tab

AI/Classic

 

All tools are divided into three groups: the preprocessing tools , , , ,  (available in the Classic mode in the

Before tab), post-processing tools , , , , ,  (in both AI and Classic modes in the After tab), and

additional (auxiliary) tools , , .

The parameters of the selected tool will be shown in a floating window that pops up when you right-click anywhere in the
Image Window. The pop-up window disappears if you click outside it.

Hint: You can use the buttons  and  (or hotkeys: Ctrl+Z  and Ctrl+Y ) to undo/redo operations made with

the pre- and post-processing tools.

 

Preprocessing Tools (in the Before tab, Classic mode):

Using these tools, you can set new image colors, indicate areas to colorize and zones that should not change.

Pencil . Use this tool to draw color strokes and thus set the colors in which the objects in the image will be

colorized.

Set the size of the pencil and then outline within the object that you want to colorize in the selected color. If the
object is multi-colored, draw the outline within the borders of the area that should be colorized in the selected
color.
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If the object is rather large or there are sharp visible boundaries within it (lighter and darker areas, for example),
draw several strokes inside the object.

If there are details inside the object that will be painted in other colors, outline them with the main color of the
object. For example, outline lips, eyes, buttons on a coat, etc.

Hint: If you want a smooth transition of color, draw the strokes farther apart from each other (the farther the
strokes are apart, the smoother the transition). If the transition needs to be sharper, draw the color strokes
closer together. This is why it is necessary, for example, to draw around the eyes and mouth with the color
chosen for the skin.

It's possible to draw several colors at once with the Pencil tool using the Multicolor mode (only for Home Deluxe
and Business licenses). It's helpful for complex patterns and objects with clear boundaries. This mode appreciably
saves you time.

Activate Multicolor mode in the options of the Pencil tool. Upon doing so, the Settings Panel will automatically
switch to the Multicolor palette.
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The Sensitivity of the color pairs:
dark-gray — red = 75
light-gray — white = 75

 

The Sensitivity of the color pairs:
dark-gray — red = 30
light-gray — white = 90

The colors used are set by adding them to color plates. The left plate shows the color that will be replaced, the
right plate shows the new color. The colors in the color plates can be set in the following ways:

- from the image (when you click the color plate, the Eyedropper tool becomes active, that allows you to
take a color from a photo); 
- from the standard Select Color dialog, which is activated by double-clicking the left mouse button on the
color plate; 
- from the Color Library which contains colors that are difficult to pick out: the color of skin, hair, lips,
grass, trees, stones, etc.

You can adjust the Sensitivity for each pair of colors. At higher values of this parameter, more shades of the
source color are taken into account when drawing strokes.

 

Keep Color Pencil . Use this protecting tool to mark objects and areas to remain unchanged.

If you want to change the color of a particular object on a color photo while keeping other areas unchanged, use
the Pencil tool to set the color for the object and then draw a closed outline around this object using the Keep
Color Pencil .

 

Keep Color Pencil Used
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Keep Color Pencil Not Used

 

Tube . Use this tool to instantly change the color and brightness range of the drawn stroke.

Magic Tube . The tool changes at once the color of all strokes with the same color and brightness range.

To change the color of a drawn stroke, select a new color, then enable the Tube tool  in the Toolbar and

left-click the stroke. If the image has several strokes of the same color and you want to recolor all these strokes,

select the Magic Tube tool  and click one of the strokes.

 

 

Color Change From Red to Blue

You can make the resulting color darker or lighter. To do this, you need to change the brightness range of the
selected color. But keep in mind that the brightness range compression can result in deterioration of the detail
and deepness of an image.

To change the brightness range for a drawn stroke, select the required brightness range, take the Tube tool 

and left-click this stroke. If you want to recolor strokes having the same color and brightness, select the Magic
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Normal Preview

 

Brightness Preview

Tube tool  and left-click one of the strokes. To recolor all strokes having the same color regardless of the

brightness range, use this tool with the Ctrl -key pressed on the keyboard (⌘  on Mac).

In the normal preview mode, all strokes are displayed in the chosen color, regardless of the brightness, i.e.
various tones of the same color will look the same. When the Brightness Preview  is activated, you can see

how the strokes will look on the resulting image.

 

Eraser . Use the tool to erase the drawn strokes. To remove an entire stroke, click it with the Alt  key (Mac:

Option ). To remove all strokes, click the image with Alt+Ctrl  (Mac: Option+⌘ ).

 

Post-Processing Tools (in the After tab):

Recolor Brush . The tool allows to change the colors in the colorized image.

Tool's Parameters:

Size (1-500). The stroke width of the brush (in pixels).

Hardness (0-100). The hardness of the outer edge of the brush. The higher the value of the parameter, the
harder the brush edge is. At the value = 100% the brush is as hard as a pencil; at a low value of the parameter
the brush strokes are soft.

Strength (0-100). The intensity of the strokes. The higher the value of the parameter, the more intense the
colors of the applied strokes are.

Keep Brightness check-box. When the check-box is enabled, the brightness of the drawn stroke is changed to
comply with the background and with the overall brightness of the image (the strokes get lighter on the light
zones of the image and darker on the dark zones). When the check-box is disabled, the brightness of the strokes
does not depend on the brightness of the image.
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Before Using the Tool Recolor Brush Applied

Before Using the Tool Tuning Brush Applied

 

Tuning Brush  (only for Home Deluxe and Business licenses). The tool allows you to recolor objects in a natural

way, add shades, halftones, and even smooth out folds, wrinkles, and get rid of unnecessary details.

Tool's Parameters:

Size (1-200). The diameter of the brush.

Hardness (0-100). The amount of blur of the outer edge of the brush. The higher the value of the parameter,
the harder the edge becomes.

Strength (0-100). The amount of influence on an image.

Smoothing Radius (0.1-10.0). At low values, the parameter smoothes out large details. At large values, it
smoothes out smaller details and keeps large ones.

Sample (0-100). When set to 0, the brush uses the color from the starting point of the stroke. The higher the
value of the parameter, the weaker the original color and the brighter the color from the palette appears. At the
value = 100, the original color is not used.

Color Mixing (0-100). The amount of blending with the selected color.
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Before Using the Tool History Brush Applied

 

History Brush . The tool restores the image to its original state, weakening or removing the colorization effect on

the selected areas.

Tool's Parameters:

Size (1-500). The maximum width of a line made by the brush (in pixels).

Hardness (0-100). The blurriness of the tool's edges. The less the value the more blurry the tool's edges
become. At value 100% the border between the brush's edges and the background is very distinct; at lower
values the transition between these areas is smoother.

Strength (1-100). The degree of restoration to the original state. At lower values there will be less restoration
and more blending with the effect; at value 100% the original image will be restored more completely.

Restore to Original. If the check-box is enabled, the original image is restored. If it is disabled, the tool restores
the result of automatic processing.

 

Darken . The tool makes the processed areas darker.

Tool's Parameters:

Size (1-500). The maximum width of a line made by the brush (in pixels).

Hardness (0-100). The degree of blurriness of the tool's edge. The higher the value, the sharper the tool's edges are.

Strength (1-100). The force of influence on the image. The higher the parameter value, the more the colors change.

Range. The drop-down menu provides three methods for darkening an image:

Shadows. Dark areas are processed more strongly than light areas.

Midtones. Dark and light areas are processed equally.

Highlights. Light areas are processed more strongly than dark areas.

 

Lighten . The tool makes the processed areas lighter.

Tool's Parameters:

Size (1-500). The maximum width of a line made by the brush (in pixels).

Hardness (0-100). The degree of blurriness of the tool's edge. The higher the value, the sharper the tool's edges are.

Strength (1-100). The force of influence on the image. The higher the parameter value, the more the colors change.
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Darken Lighten Saturation

Range. The drop-down menu provides three methods for darkening an image:

Shadows. Dark areas are processed more strongly than light areas.

Midtones. Dark and light areas are processed equally.

Highlights. Light areas are processed more strongly than dark areas.

 

Saturation . The tool allows you to change the intensity of colors, making them paler or brighter.

Tool's Parameters:

Size (1-500). The maximum width of a line made by the brush (in pixels).

Hardness (0-100). The degree of blurriness of the tool's edge. The higher the value, the sharper the tool's edges are.

Strength (1-100). The force of influence on the image. The higher the parameter value, the more the colors change.

Mode. In Saturate mode, colors become more saturated, in Desaturate mode, colors become less saturated.

 

Additional Tools:

Eyedropper . The tool allows you to select colors from the image.

Hand . The tool lets you scroll the image when it does not fit within Image Window at the desired scale. To use it,

click the button, bring the cursor over the image, and while keeping the left mouse button pressed move in the desired
direction. The hotkey is H . 

Double-clicking on the tool’s icon   on the Toolbar makes the image fit the window.

Zoom . The tool lets you change the image scale. To zoom in, click the image. To zoom out, click the image with

Alt . The hotkey is Z . 

Double-clicking on the tool’s icon   makes the image scale to 100% (actual size).
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Color Image (Check-Box is Disabled) Black And White Image (Check-Box is Enabled)

Brightness = -50 Brightness = 50

Contrast = -50 Contrast = 50

IMAGE PREPROCESSING

The Preprocessing tab contains parameters for preliminary processing that help to enhance an original image before
colorization. You can turn a color photo into grayscale, adjust the image brightness and contrast.

 

Grayscale. Enable the check-box to convert the original image into black and white.

Brightness. The strength of the image luminosity. Increasing the parameter makes the pixels lighter, decreasing it
makes them darker.

Contrast. Increasing the parameter increases the difference between bright and dark areas of the image.
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SAVE AND LOAD STROKES (CLASSIC MODE)

While coloring an image in the Classic mode in AKVIS Coloriage AI, periodically save your strokes to a file with the .strokes
extension, so that you do not have to repeat your work from the beginning, if for some reason you are interrupted.

To save the color strokes, click  and indicate a folder and a file name. Later you can load the strokes from this file using 

 and continue working with the image.

In case of some unexpected event (such as a power loss, etc.) the program autosaves the strokes into the coloriage-
autosave.strokes file each time when you run processing .

You can find the autosaved file here:

Windows: C:\Users\Public\Documents\AKVIS
macOS: /Users/Shared/AKVIS
Linux: /var/lib/AKVIS.

 

Saving strokes is also a way to share your experience of using the program with others.

We offer you photos to colorize using half-finished projects.

Step 1. Download and unpack an archive with the original image and the .strokes file for it.
Step 2. Open the image.

Step 3. Click  and select the .strokes file for this image, then press Open.
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Step 4. Click  and the result of the colorization will be shown in the After tab.

Step 5. You can change the colors of the image. For this purpose, go to the Before tab and use the Tube  or the

Magic Tube  to change the color of the strokes. The Tube changes the color of one stroke, the Magic Tube

changes the color of all strokes having one color.
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Press the button  again.

Attention! The strokes in the archive correspond to the dimensions of the initial image (width x height). If you change the
dimensions of the original image, the file with the strokes will not fit the image.

 

Download these archives with color strokes and colorize the images in a click:

baby-photo.zip, boy-picture.zip, car-color.zip, family-photo.zip, girl-portrait.zip,
house-color.zip, interior.zip, pool-swimmers.zip, postcard.zip, settlers.zip.
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COLORIZATION TIPS

Follow our colorization tips to start to be an expert in photo colorizing. These tips will help you learn how to add color to
your black and white images, replace colors in color photos, and how to optimize your work using AKVIS Coloriage AI.

 

When selecting a color take into account that the final result depends on the brightness of the original color.

If you are not satisfied with the result you can make the final color lighter or darker. For this purpose, change the
brightness range of the selected color. Take into account that the brightness range compression (especially if it is
strong) will inevitably result in deterioration of the detail and deepness of an image.

 

Colorization will look natural if you select less saturated colors for your black and white photo.

 

To get a smooth color transition (i.e., when assigning several colors for the sky or for verdure), draw strokes far from
each other; if you want to have a sharp color transition (i.e. when assigning colors for eyes, lips, etc.), draw strokes
close to each other so that the colors won't flow.

 

To remove strokes, use the Eraser tool . The shortcut for the tool is the E  key.

If you want to remove an entire stroke, press the Alt  key (Mac: Option ) and click this stroke.

To remove all strokes, press the keys Alt+Ctrl  (Mac: Option+⌘ ) and click the picture.

 

To recolor a drawn stroke (or change its brightness range), select a new color (or brightness range), activate the
Tube tool , and click the stroke. 

If you want to recolor several strokes having one color, enable the Magic Tube  and click one of such strokes - all

the strokes of this color will be recolored.
To recolor all strokes having the same color regardless of the brightness range, use the Magic Tube  with the

Ctrl -key pressed on the keyboard (⌘  on Mac).

 

To draw a straight line, activate the Pencil  tool, press the Shift  key and left-click the start point of the line

and on the finish point. In this way you can draw a polygonal outline.

 

To color complex patterns and objects with clear boundaries, use the Multicolor tool. This saves time, because of
instead of drawing many strokes, you can draw just one, which changes color according to the initial color field over
which it passes.

 

Save the strokes! To be on the safe side, we recommend you to always save the strokes that you draw into a
separate file.

It is helpful if you have to interrupt your work before you set colors for every object or if you want to edit the colorized
photo in the future (change the color scheme, edit strokes).
To save the strokes, press the button , to load strokes press . See an example of using the strokes file.

 

Use hotkeys for quick access to the tools: Pencil  - the B  key, Eraser  - the E  key, Eyedropper  - the

I -key, Tube  - the G  key.

 

To regulate the brush size for the Pencil , Keep Color Pencil , Eraser , Recolor Brush , Tuning

Brush , and History Brush , use the drop-out scale that appears when you press the button of the

corresponding tool.
Use hotkeys: to reduce the brush size press the key [ , to increase the brush size press the key ] .

 

To change the image scale use the Navigator or the following hotkeys: +  and Ctrl++  (⌘ ++  in Mac) to increase

the scale, -  and Ctrl+-  (⌘ +-  in Mac) to reduce the scale.

AKVIS Coloriage AI

46



 

If you want to cancel the last action with the button Undo  or using Ctrl+Z  (Mac: ⌘ +Z ).

Restore the changes with the button Redo . The hotkeys are Ctrl+Y  (Mac: ⌘ +Y ).

 

Pick colors from the other photo using the Sample Image tab.

 

Use the Preprocessing parameters for preliminary processing of the original photo. You can adjust the brightness
and contrast of the image and convert it into grayscale.
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PROGRAM PREFERENCES

The button  opens the Preferences dialog box. It looks like this:

Language. Change the program language by selecting another from the drop-down list.
Interface Scale. Choose the size of the interface elements. When it is set to Auto, the program workspace will
automatically scale to fit the screen resolution.
Interface Theme. Select the style of the program interface: Light or Dark.
Recent Files (only in the standalone version). The number of recent documents. The list of the recent files, sorted by
time, become visible by right mouse clicking on . Maximum: 30 files.

Initial Image Scale. This option defines the way the image is scaled in the Image Window.

- Fit to View: the image is completely visible in the window;
- 100%: the image doesn’t scale (generally, only a part of the image is visible).

Save Result in RGB (only in the standalone version). By default, the processing result is always saved in RGB,
regardless of the source image. If the original image was in CMYK or Lab and you want to save the result in those
modes, deactivate this parameter (if the result is saved in CMYK mode, it might appear differently than in the program's
image window). A result in Grayscale will always be saved in RGB.
Lock the Control Panel check-box. It disables the possibility to hide/show the top panel. If the check-box is selected
the panel is always visible. Uncheck the option to unlock the panel, and you will be able to hide/show it by clicking on
the small triangle button (in the middle of the panel). The minimized panel will be shown when moving the cursor over it.
Variations. The check-box shows/hides a section with colorization results.
Use CPU in AI Mode (only on Windows). When the check-box is enabled, the program uses the processor instead of
CUDA. We recommend using this option if you have problems with GPU calculations. On Mac and Linux computers, this
option is unavailable, these versions can only use the CPU.

Click OK to apply the changes. To reset to the default options, click Default.
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BATCH PROCESSING

AKVIS Coloriage AI supports the Batch Processing feature that lets you add color to multiple images at once, in the AI
mode.

Just choose a folder with black and white photos or with movie frames. All images will be colorized automatically.

 

If you use the standalone version of AKVIS Coloriage AI, read the instructions here.

If you use the plugin in a photo editor, create an action with Coloriage AI and call the batch processing via the Automate
menu. Learn more.
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PRINT IMAGES IN AKVIS COLORIAGE AI

In the standalone version of AKVIS Coloriage AI you can print the image. Press the button  to open the Print options.

Print Options in AKVIS Coloriage AI

Adjust the parameters appearing in the Settings Panel:

Choose a printer from the list of available devices, set the desired resolution, as well as the number of copies to print.

In the Orientation group, set the position of paper: Portrait (vertically) or Landscape (horizontally).

Click the Page Setup button to open a dialog box to choose the size of the paper and its orientation, as well as the
print margins.

Press the Reset Margins button to return the page margins to the default size.

Change the size of the printed image adjusting the parameters Scale, Width, Height and Fit to Page. These
parameters have no effect on the image itself, just on the print version. You can change the size of the printed image
by entering any value in %, or by entering new values in Width and Height.

To adjust the size of the image to the paper size, select Fit to Page.

Move the image on the page with the mouse or align it using the arrow buttons.

You can activate Frame for the image and adjust its width and color.

Choose the Background Color by clicking on the color plate.

In the Page tab, you can adjust printing of the multiple copies of the image on a single sheet.
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Print Page

Copies per Page. It lets you specify the number of copies of the image on one page.
Horizontally and Vertically. These parameters indicate the number of rows and columns for the copies of the
image on the page.
Spacing. The parameter sets the margins between the copies of the image.

In the Poster tab, it's possible to customize printing of the image on multiple pages for the subsequent junction into a
large picture.

Pages. If the check-box is enabled, you can specify the maximum number of the pages in which the image will be
divided. The image scale will be adjusted to fit this number of the sheets. If the check-box is disabled, the
program will automatically select the optimal number of the pages in accordance with the actual size of the image
(scale = 100%).
Glue Margins. If the check-box is enabled, you can adjust the width of the padding for bonding sheets. Margins
will be added to the right and to the bottom of each part.
Show Numbers. With the enabled check-box, a sequence number of each part, by a column and a row, will be
printed in the margins.
Lines of Cut. Activate the check-box to display the cut marks in the margins.

To print the image with the chosen parameters, press the Print button. 
To cancel and close the printing options click on Cancel.

Click the Properties... button to open a system dialog box that enables you to access the advanced settings and send the
document to print.
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SELECTIVE COLORIZATION OF B&W PHOTOS

In tutorials for AKVIS Coloriage AI you can find many examples of colorization of black and white photos. But it is also
possible to add color to only one object of the image in order to place special emphasis on it. In some cases partial coloring
can be particularly useful.

 

Follow the instructions to colorize a part of the photo:

Step 1. Open a black and white image. We choose the photo of the young sportsmen.

Step 2. In the Classic mode, use the Pencil tool  to assign colors to the key figure of the image. In our case we

will colorize the boy who wins the race.

We choose colors for his clothes, his hair, eyes, teeth, lips and the color of the finish ribbon.

Step 3. Use the Keep Color Pencil tool  to draw a close outline around the key object (the winner and the ribbon).

If it is not possible to draw a close outline, the "keep color" line should go beyond the photo frame, so that there are no
gaps between the "keep color" outline and the image.

Step 4. Press the button  to start the colorization process.

In a few steps you have got a partially colorized photo.

AKVIS Coloriage AI

52



 

AKVIS Coloriage AI

53



SELECTIVE DESATURATION

You will see how to desaturate a part of the image leaving other parts untouched. You won't need to select the areas to be
desaturated precisely.

 

We use the plugin version in this tutorial, but you can take the standalone program and do the same to achieve this result.

Step 1. Open the color photo in your photo editor.

Step 2. Call the AKVIS Coloriage AI plug-in. For this purpose in AliveColors select the menu item Effects –> AKVIS –
> Coloriage AI; in Adobe Photoshop select the menu item Filter –> AKVIS –> Coloriage AI; in Corel Photo-Paint -
select the menu item Effects –> AKVIS –> Coloriage AI.
Step 3. In the Classic mode, select the Keep Color Pencil  and draw an outline inside the butterfly that should

keep its colors. You do not need to outline the butterfly feelers as they are black and will have the same color after the
desaturation.

Step 4. Select a gray color (the easiest way is to use the Swatches palette) and outline the butterfly using the
Pencil tool .
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Step 5. Start the process of the selective desaturation by pressing the button .

Now it is a gray scale picture, only the butterfly has kept its colors.

Step 6. Apply the selective desaturation to the photo by pressing the button .

You can experiment with other photos, for example, with a portrait.

Selective desaturation allows you to highlight key points and see the photo in a different way.
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CHANGING COLOR OF YOUR CAR

You can colorize this car yourself using the half-finished materials that we give you. Download an archive containing the
original image and the file with the strokes (*.strokes). Read the instruction here to see how it works.

This example shows how to replace colors on a color photo keeping other colors unchanged.

We will apply AKVIS Coloriage AI to change the yellow color of the car body, while other colors (the color of the roof,
headlights, wheels, the sky, the snow, etc) will stay the same.

 

We use the plugin version in this tutorial, but you can take the standalone program and do the same to achive this result.

Follow these instructions:

Step 1. Open the original color photo with the car.

Step 2. Call the AKVIS Coloriage AI plug-in. For this purpose in AliveColors select the menu item Effects –> AKVIS –
> Coloriage AI; in Adobe Photoshop select the menu item Filter –> AKVIS –> Coloriage AI; in Corel Photo-Paint -
select the menu item Effects –> AKVIS –> Coloriage AI.
Step 3. In the Classic mode, select a color for the car body. You should take into account that the original color of
the car body is light-yellow, therefore the resulting color will also be light. In this case it is impossible to get a dark-blue
or a vinous color. Select a light color from the Color (or Swatches) palette, for example, lilac.
Step 4. Select the Pencil tool  and draw an outline within the car body following the shape of its boundaries. As

some car details that fall into the contour should not be painted (the air pipe, the door-handle, etc) you should outline
them with the color selected for the body.
Step 5. Select the Keep Color Pencil  and draw a closed outline around the car body. The contour should be

drawn around the boundaries of the car body and pass all objects that are contiguous to the car body, but the color of
which should stay the same (for example, the background, headlights, roof, windows, wheels of the car). The contour
must be closed. We will use the same tool to mark the air pipe, the door-handle and other details that fall into the
contour of the car body.

Hint: If you make a selection in the image editor it will be transferred to the plug-in and displayed as the outline
made with the Keep Color Pencil. So you will only need to draw the color strokes inside the selection using the
Pencil.

AKVIS Coloriage AI

56

https://akvis.com/img/examples/coloriage/strokes/car-color.zip


Step 6. Press the button . The result of the colorization will be shown in the After tab.

Step 7. Apply the result of the colorization by pressing the button .

Below are other versions of colorization of the car body.
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ADDING COLOR TO AN OLD POSTCARD

You can colorize this photo yourself using the half-finished materials that we give you. Download an archive containing the
original image and the file with the strokes (*.strokes). Read the instructions here to see how it works.

It is beyond question that black and white photos have their charm. However, sometimes, adding color to a grayscale photo
can help us to see it in a new light, to perceive new details. This postcard is a good illustration to this statement.

 

We use the plugin version in this tutorial, but you can take the standalone program and do the same to achive this result.

Follow the instructions to "breathe new life" into the postcard:

Step 1. Open the image in your photo editor.
Step 2. Call the AKVIS Coloriage AI plug-in. For this purpose in AliveColors select the menu item Effects –> AKVIS –
> Coloriage AI; in Adobe Photoshop select the menu item Filter –> AKVIS –> Coloriage AI; in Corel Photo-Paint -
select the menu item Effects –> AKVIS –> Coloriage AI.
Step 3. In the Classic mode, select a color for every object of the image.

Take your time and outline with  the big objects (for example, the girdle, the dress, the cushion, the plaid, and the

furs on the sofa) following their boundaries.

To colorize the small details, draw finer strokes on them. For example, to color the pearls a line drawn inside every
thread of the beads will be enough. To paint the eyes, just draw some strokes inside the eye iris and on the white of
the eye.

Step 4. Press the button  to start the colorization process. The colorized image will be shown in the After tab.

Step 5. Press the button  to apply the results of the colorization and close the plugin window.
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Step 5. Press the button  to apply the results of the colorization and close the plugin window.
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AKVIS PROGRAMS

 

AKVIS AirBrush — Airbrushing Techniques on Your Photos

AKVIS AirBrush automatically transforms a photograph into a work of art which looks like made with a special airbrush tool
that sprays paints or inks. The software works as an artistic filter creating stylish colorful airbrush designs from images using
chosen settings of photo-to-painting conversion. More…

 

AKVIS Artifact Remover AI — JPEG-Compressed Image Restoration

AKVIS Artifact Remover AI uses artificial intelligence algorithms to remove JPEG compression artifacts and restore the
quality of compressed images. This program provides 4 image enhancement modes, each involves a unique neural network
developed especially for this occasion. The software is available free of charge for home users. For commercial use, a
Business license is offered. More…

 

AKVIS ArtSuite — Frames and Effects for Your Photos

AKVIS ArtSuite is an impressive collection of versatile frames and effects for photos. ArtSuite contains many templates and
texture samples that can be used to create a virtually limitless variety of options for generating frames.
Decorate a photo to give it an original and festive look! More…
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AKVIS ArtWork — Collection of Painting & Drawing Techniques

AKVIS ArtWork is photo to painting software designed to imitate different artistic techniques: Oil Painting, Watercolor,
Gouache, Comics, Pen & Ink, Linocut, Stencil, Pastel, and Pointillism. ArtWork helps you to create a piece of art out of any
picture! More…

 

AKVIS Chameleon — Photo Collage Creation

AKVIS Chameleon is a fun to use tool for photo collage creation. It makes the process easy and entertaining. The tool is
very easy to handle as it does not require precise selection of objects.
Using the software you can quickly create your own photo collages. More…
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AKVIS Charcoal — Turn Photos into Charcoal & Chalk Drawings

AKVIS Charcoal is a creative tool for conversion of photos into charcoal and chalk drawings. Using the program you can
make professional-looking expressive black and white images. Playing with colors and options you can achieve outstanding
artistic effects such as sanguine, sepia, and others. More…

 

AKVIS Coloriage AI — Add Color to Black and White Photos

AKVIS Coloriage AI allows colorizing B&W photos. The program includes an AI-powered image colorization mode based on
machine learning, as well as the classic method of manual coloring using zone selection. Breathe new life into your old family
photographs! More…

 

AKVIS Decorator — Resurface and Recolor

AKVIS Decorator lets you change the surface of an object in a realistic manner. The program puts on a texture keeping the
volume of an object, following its folds and creases. The new pattern looks absolutely natural and makes you see things
differently. Recoloring is also made easy. More…
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AKVIS Draw — Hand-made Pencil Drawing Effect

AKVIS Draw converts your photos into hand made pencil drawings. The software creates realistic looking line art illustrations,
produces both B&W and color drawings. Add a hand-drawn look to your pictures! More…

 

AKVIS Enhancer — Bring Detail To Your Pictures

AKVIS Enhancer is image enhancement software that detects detail in underexposed, overexposed and mid tone areas of a
photo with uneven exposure. Enhancer improves every part of the image! The software works in three modes: Improve
Detail, Prepress, and Tone Correction. The program offers a fast method to fix a dark photo, add contrast and brightness to
a picture, it lets you improve color and adjust tones. More…

 

AKVIS Explosion — Fabulous Particle Explosion Effects

AKVIS Explosion offers creative destruction and particle explosion effects for your photos. It bursts an object and applies
dust and sand particles to an image. With the software, you can create eye-catching graphics in just a few minutes! More…
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AKVIS Frames — Decorate Your Photos with Frames

AKVIS Frames is a free program designed for working with the AKVIS frame packs

 

AKVIS HDRFactory — High Dynamic Range Images: Brighter than Reality!

AKVIS HDRFactory lets you create a High Dynamic Range image from a series of shots or from one single photo. The
program can also be used for photo correction. The program brings life and color to your photos! More…

 

AKVIS Inspire AI — Artistic Stylization of Images

AKVIS Inspire AI stylizes images using various samples of painting. The AI-based program applies the color scheme and style
of a selected artwork to a photo creating a new masterpiece. The software includes a gallery of art styles and allows to load
a custom sample. Imitate the style of world famous artists! More…
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AKVIS LightShop — Light and Star Effects

AKVIS LightShop lets you create an infinite number of astounding light effects! The program offers advanced lighting
techniques for adding stars and glow effects to images. A light effect draws attention and brighten up any photo. Add a little
magic to your pictures! More…

 

AKVIS Magnifier AI — Enlarge Images & Enhance Quality

AKVIS Magnifier AI allows you to increase the size of photos and improve image quality and appearance. Featuring neural
network-based algorithms, Magnifier AI upscales images to super-high resolution, up to 800%, and produces wall-sized prints.
Improve image resolution, create clear, detailed images with perfect quality! More…

 

AKVIS MakeUp — Retouch Your Portrait Photos!

AKVIS MakeUp improves your portraits giving them a professional look. The software retouches facial imperfections making
your skin radiant, beautiful, pure and even. The program adds glamour to your pictures and creates a high key effect. Look
your best in every photo with AKVIS MakeUp! More…
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AKVIS NatureArt — Bring Nature to Your Photos

AKVIS NatureArt is an excellent tool for imitating the magnificence of natural phenomena on your photos. The program
includes a number of effects: Rain

 

AKVIS Neon — Glowing Drawings from Photos

AKVIS Neon lets you create amazing glowing lines effects. The software transforms a photo into a neon image that looks like
drawn with luminescent ink. More…
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AKVIS Noise Buster AI — Digital Noise Reduction

AKVIS Noise Buster AI is software for noise suppression on digital and scanned images. The program is efficient for removing
any type of digital noise. It reduces both luminance and color noise without spoiling other aspects of photos. The software
includes AI technologies and adjustments for manual refining. More…

 

AKVIS OilPaint — Oil Painting Effect for Your Photos

AKVIS OilPaint turns your photos into oil paintings. The mysterious production of a painting happens right before your eyes.
The unique algorithm authentically reproduces the technique of the real brush. With this cutting-edge software you can
become a painter! More…

 

AKVIS Pastel — Turn Photos into Pastel Paintings

AKVIS Pastel turns your photos into pastel paintings. The program converts your photo into a lifelike digital art imitating one
of the most popular artistic techniques. AKVIS Pastel is a powerful tool to unleash your creativity! More…
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AKVIS Points — Apply Pointillism Effect to Your Photos

AKVIS Points lets you transform your photos into paintings using one of the most exciting artistic techniques - pointillism.
With the software you can easily create gorgeous works of art in a pointillist manner. Discover the world of bright colors!
More…

 

AKVIS Refocus AI — Focus Improvement & Blur Effects

AKVIS Refocus AI improves the sharpness of out-of-focus and blurry photos, enhances the entire image or partially, creating
a selectively focused area. It's also possible to add bokeh and lens blur effects to your photos. The program provides five
image processing modes: Refocus AI, Tilt-Shift, Iris Blur, Motion Blur, and Radial Blur. More…

 

AKVIS Retoucher — Image Restoration Software

AKVIS Retoucher is an efficient program for photo restoration and photo retouching. The software removes dust, scratches,
stains, and other defects that appear on damaged photos. It intelligently reconstructs the missing parts of the photo using
the information of the surrounding areas. More…
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AKVIS Sketch — Turn Your Photos into Pencil Sketches

AKVIS Sketch converts photos into amazing pencil drawings. The software creates realistic color artworks and B&W
sketches, imitating the technique of graphite and color pencil. The program offers these photo to drawing conversion styles:
Classic, Artistic, Maestro, and Multistyle, - each with a series of presets. AKVIS Sketch allows you to feel like a real artist!
More…

 

AKVIS SmartMask — Save Time on Complex Selections!

AKVIS SmartMask is an efficient selection tool that saves time and is fun to use. Selection has never been so simple! The
software considerably increases your productivity. You will be freed from boring work and will have more room for creativity
and realization of your ideas. More…
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AKVIS Watercolor — Aquarelle Art from Photos

AKVIS Watercolor easily makes a photo look like a brilliant and vibrant watercolor painting. The program includes two styles
of photo to painting conversion: Classic Watercolor and Contour Watercolor; each comes with a wide range of ready-to-use
presets. The software turns ordinary images into aquarelle pieces of art. More…
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